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While reasonable efforts have been made to ensure that the contents of this document are accurate, the document
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Document History

Revision Published Summary of Changes

1.0 May 2021 First edition — Updates for version 11.3.0.
2.0 February 2022 Second edition — Updated for version 11.8.5.
3.0 May 2022 Third edition — Updated for version 11.8.9

This document describes how to integrate Calypso with Bloomberg Data License for market data.

Forinformation on integrating products, corporate actions, and trades from Bloomberg DL, please refer to the
Calypso Bloomberg DL Products Integration Guide for details.

Forinstallationand setup requirements, please refer to the Calypso Bloomberg DL Products Integration Guide
for details.

NOTE: The Calypso License to use this Calypso Integration Module does not include a license for any
third-party data services to which this module can interface. Clients are responsible for contracting with
the appropriate third-party data service(s) prior to using this Calypso Integration Module.

IMPORTANT NOTE: For Cloud deployments please contact your application management team as the
deployment procedure for Cap Cloud is different.
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Quotes via the Feed Address Window

1.1 Feed Configuration
You need to specify a Feed Configuration to access the Bloomberg platform.

If you are using multiple user accounts, create a feed config for each user account for the Bloomberg type.

A FeedConfig Window >
Mame Bloomberg Type | Bloomberg Bt Is Default
Mame Value
L | dtsftp.bloomberg.com
Port 30206
Log
UserName dlgn4d
Password L 111 1])
SSHPrivateKeyPath C:ibbg'bbg_id_rsa
SS5HPassPhrase calypso

HostName replaces BLOOMBERG_FTP_HOST

Port replaces BLOOMBERG_FTP_PORT

UserName replaces BLOOMBERG_FTP_USER

Password replaces BLOOMBERG_FTP_PASSWORD

SSHPricateKeyPatch replaces BLOOMBERG_SFTP_PRIVATE_KEY_FILENAME
SSHPassPhrase replaces BLOOMBERG_SFTP_PASSPHRASE

The Feed Config can be selected in the Bloomberg Connect and Bloomberg Update windows.

1.2 Feed Address Mapping

Clients can use the Feed Address window to map and define a list of quotes to their corresponding Bloomberg
fields for a given feed config.
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P Feed Address Window (User: calypso_user) -1gj =|
Feed IBIDUmberg j Quote Address IEquity.IBM
Quote Type IPrice j Feed Address IIBM US Equity = | 1.0 + | 0.0

Names Like | sd [P e ask [P _ask High [PX_HIGH Last [PX_LAST
Open  [Px_oPEN Close | Low [PX_LOW Date |

Ac Quote Address | Type Feed Feed Address | Mult | Add | Bid Name | Ask Mame | Open
Equity. IBE.MC | | [Equity.AMZN_ [Price |Bloomberg [AMZN LS Equity i OPxBID  |PX_ASK  [Px_OPI
m‘l Equity.J5M Price [Bloomberg [IBM US Equity 1| ofxED  [Pu_ask  [Px_oF
Fquity. ICE
Equity. IFF
Equity. IFL.AX —

Quote Address is a Calypso quote name.
Feed Address specifies the Bloomberg code for the quote corresponding to a Calypso Quote Address.
Examples

e Currency Quote Address

Calypso: FX.USD.JPY

Bloomberg: USDJPY Curncy

e Equity Quote Address (required for gethistory)

Calypso: Equity.IBM

Bloomberg: IBM US Equity

You can then use the specified feed address config in the Bloomberg Update Window, “Template” field to request
the corresponding quotes.

Ensure that you also create Scheduled Tasks for making the request and processing the response.

[NOTE: Requesting additional fields invokes a normal Equity or Equity Index update.]

From the Feed dropdown, select the previously defined Bloomberg feed. Click Load All to display existing
mappings.

Click Refresh to load the Addresses list (i.e., Calypso quote names). You can filter the list by selecting a quote type
from the Quote Type dropdown or by entering a search string in Names Like (e.g., MM.USD.LIBOR) and clicking
Refresh.

To Add a New Mapping

[NOTE: It is possible to map multiple assets to a single feed address.]

Select a Calypso quote name from the Addresses list.

Enter the corresponding Bloomberg quote name in the Feed Address. Enter a multiplier value and spread value as
applicable.

Enter Bloomberg real-time field names as applicable.
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[NOTE: The default date that the system saves with the quote is Today.]

Click Add.

Repeat for other quote names.
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Historical Data

2.1 Overview

The gethistory program retrieves various historical data fields for a specified list of securities within a given date
range. Bloomberg support for historical data includes Quotes (End-of-Day pricing) and Swaption Volatility.

Calypso Bloomberg Integration supports Quotes (End-of-Day pricing) at this time. The following table provides a
listing of Bloomberg fields available via the gethistory program:

Field Mnemonic Field Description

PX_ASK Ask Price
PX_BID Bid Price
PX_MID Mid Price
PX_LOW Low Price
PX_HIGH High Price
PX_OPEN Open Price
PX_LAST Last Price

Use the Calypso Feed Address window to map Calypso Quote Addresses to Bloomberg Quote Addresses.

2.2 Using Gethistory

To obtain historical pricing information, first open the Bloomberg Update window from Bloomberg Connect.

A Bloomberg Update

1 Bloomberg Updates
—-2] oneshot
42 MBS_FLOWS
~- 42 UpEquities

~42 UpdateIndex

Update Definition

Program:

Name:
Frequency:
Period:

Currency:

Pricing So...

Feed:

— | X
gethistory e Template Type: |Quote
one_history Template Name | Bloomberg w
oneshot ~ Run Date: (YYYYMMDD)
daily v Exec Time: (HHMM])
ANY w Date Range: (YYYYMMDD)
v Snapshot:

Exclusive Pricing S...

Add Custom Header
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Historical pricing is retrieved using the gethistory program.
When the gethistory program is selected, the following additional fields are available:

e Delay Limit — The nominal frequency of use for this update template.
e Period — The nominal pricing period.
e Currency — The desired pricing currency.

e Date Range — Aninclusive range of days to retrieve historical pricing. The limit set by Bloomberg is seven
days before the Run date (typically, today). When Frequency is oneshot, Date Range is mandatory.
gethistory will return a single day if Date Range is left blank (except for oneshot requests).

e Feed - You can select a feed config if you are using multiple user accounts. Otherwise,
BLOOMBERG_STP_USER is used.

After saving, request the data either via a scheduled task or from the Bloomberg Connect window.
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Snapshot Pricing Data

3.1 Overview

Calypso’s Bloomberg Integration Module supports the retrieval of quote snapshots from the Bloomberg Data
License Server using the Getsnap program. This includes the following:

e Use Getsnap to request, receive, and process a quote snapshot.
e Process Bloomberg quote snapshots of past dates.

In conjunction with the ability to create daily scheduled requests, users can now reliably retrieve daily quote values
with a precisely defined timestamp and with the possibility of a correct recovery in case of a failure.

Bloomberg's Data License Pricing Snapshot offers a service to satisfy existing Data License Per Security clients
needing a price returned with higher precision at a specified time or valuation point.

3.2 Getsnap Feed Config

You need to define a different Feed Config for getsnap as the Feed Address Mapping differs from which of the
other programs.

A FeedConfig Window >
MName BDL237 Type |Bloomberg At Is Default
Name Value

HostName disftp.bloomberg.com

Port 30206

Log

UserName dl237

Password 2000000000 0®
SSHPrivateKeyPath C:blpbbg_id_rsa
SSHPassPhrase (111 IJIIIITIT)
BloombergUserNumber 12345

3.3 Getsnap Feed Address Mapping

In the Feed Address Window (Configuration > Market Data > Feed Address Mapping from the Calypso Navigator),
define a mapping for each security you wish to use with Getsnap for this new Feed Config. When the Getsnap
program is run, it will not execute for securities that do not have an appropriate mapping defined.
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ZFeed Address Window (User: calypso_user) -0l x|
Feed IBIoombergDataLicen. . | Quote Address IBond.UKT 5 03/07/18.03-07-2018.5.00000
QuoteType  [Cleanrice ~|  FeedAddress [Fsassa042 cusre - 10 +| 0.0
i BID PRICE i
PR I Bid Ask  |ASK PRICE High [HIGH PRICE Last [LAST PRICE
Open |OPEN PRICE Close |PREVIOUS CL Low JLOW PRICE Date |PREVIOLS CL
Addresses : Quote Address Type Feed Feed Address
Bond.T 2 3/4 02/15/19,02-15-2019, 2, 75000 :I Bond UKT 5 03/07/18,03-07-2018,5.00000 |CleanPrice |BloombergDatalicense EG4569042 CUS!
Bond.T 3 1/2 02/15/18.02-15-2018, 3. 50000 = Bond.UKT 5 03/07/18.03-07-2018.5.00000 |CleanPrice |BloombergDatalicenseGetSnap [EG4569042 CUS

Bond.T 4 12 08/15/39.08-15-2033,4,50000
Bond.T & 3/4 08/15/26.08-15-2026.6.75000
Bond.UKT 3 3/4 09/07/19.08-07-201%. 3. 75000
Bond UKT 3 3/4 09/07/20,09-07-2020, 3, 75000
Bond.UKT 4 03/07/22,03-07-2022,4,00000
Bond.UKT 4 3/4 03/07/20.03-07-2020.4.75000
Bond.UKT 5 03/07/18.03-07-2018.5.00000

Rond 1 IKT & 0AM7/71.06-07-2021.8. 00000

Take note that the fields for Getsnap differ from those available for other programs:

Calypso Field Bloomberg Getsnap Field (Typical)
Bid BID PRICE

Ask ASK PRICE

High HIGH PRICE

Last LAST PRICE

Open OPEN PRICE

Close PREVIOUS CLOSE PRICE

Low LOW PRICE

Date PREVIOUS CLOSE DATE

It is possible to map the Close field with “LAST PRICE” if the user wants to feed LAST PRICE into the close instance
of a quote. If the user wants to feed data on Today’s market data set, then while defining mapping, the Date field
can be left empty and the quote received will be fed in Today’s quote set. The response file can also be used to
feed the previous close price into the previous close date. In that case, Close should be mapped to “PREVIOUS
CLOSE PRICE” and Date should be mapped to “PREVIOUS CLOSE DATE”. This setting will feed the value in the
Previous Close price field into the close instance of quote set for date corresponding to “PREVIOUS CLOSE DATE”
field of the response file.

Below is an example that shows how to feed LAST PRICE in the close instance for today.
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A
| Feed BDLIRD v Quote Address Swap. 10Y,EUR.EURIBOR. 3M/1Y.CURVE
Quote Type  vield v Feed Address EUSW10V3 Cumncy - 001 + 0
Names Like Bd Ask High Last |LAST PRICE
Open Close LAST PRICE Low Date
Quote Address Type Feed Feed Address Mut Add BidName AskName OpenName CloseName HghName LowName LastName Date Name
A | [5wap. 101.CNY.REPO. LWAUSD.LIBOR. 3M.CLRVE FOLRD (CWBSIOCumcy | 00001 0 | pasTeRICE | | LasTeRICE | |~
0.0001 0 ILAST PRICE ILAST PRICE |
[To01 0 LASTPRICE | [ [LASTPRICE | |
[ oot o | [ LASTRRICE | | I |
| 0,01 o | | LASTPRICE | \
0
0

3.4 Using Getsnap

To obtain Snapshot pricing from Bloomberg, open the Bloomberg Update window:

A Bloomberg Update - O >
1 Bloomberg Updates 4 Update Definition
- oneshot Program: | getsnap ~ Template Type: | Quote
Name: |getsnapUpdate Template Name | BloombergDataLicense
Frequency: oneshot ~ Run Date: (YYMMDD)

ime: HHMM
Pricing So... - Snap Time: 0800 ( )

Delay Limit:
Exclusive Pricing 5... elay Limi
Add Custom Header

Feed: v

Snapshot pricing is retrieved using the Getsnap program.
When the Getsnap program is selected, the following additional field is available:

e Delay Limit— The number of minutes in which Bloomberg must produce a response file. Securities having
longer embargoes are not included in the response and reply files.

[NOTE: Calypso provides a means to automatically convert the SNAPTIME sent in the Request file to the
Data License Server timezone.]

e Feed - You can select a feed config if you are using multiple user accounts. Otherwise,
BLOOMBERG_STP_USER is used.

After saving, request the data either via a scheduled task or from the Bloomberg Connect window.

The user must also create a Feed Config and Feed Address mapping for Getsnap.

[NOTE: Make sure that all currencies have an ISO code.]

May 2022 Revision 2.0 / Approved Page 11/ 25
Private and Confidential



Nasdaq Calypso
l’lNanaq Bloomberg DL Market Data Integration Guide / Version 11.8.9

3.5 Send and Receive Getshap Updates via BLOOMBERG_UPDATE

The Scheduled Task window (Configuration > Scheduled Tasks from the Calypso Navigator) can be used to define
a BLOOMBERG_UPDATE scheduled task. Parameters can be set to include getsnap updatesin the Scheduled Task.
Task Description
Task Type: BLOOMBERG_UPDATE
External Reference:
Comments:
Description:
Execution Parameters
Attempts: |1 Retry After: |0 minutes  Expected Execution Time (SLA):
VM Settings: |-Xms512m -Xmx1024m

Log Settings:

Task Notification Options

|:| Send Emails |:| Publish Business Events  To User: e
[ common Attributes
= Task Attributes

Action 1 - Send Request for Updates

DIFFFLAG

Update Names getsnapupdate

Input Dir

Input Files

Update Known Date

Getsnap updates use the same workflow as the other Program types. When the BLOOMBERG_UPDATE scheduled
task is run and includes Getsnap Updates:

e Calypso generates request files for each selected update, including selected Getsnap updates.

e Calypso uploads the request files to the Bloomberg FTP.

e Bloomberg generates the response and reply files. The response files contain verification that each
requested security has a valid ID, while the reply files contain the requested quotes as well as the
verification.

e Calypso downloads the corresponding reply files. Calypso will not download or process the Getsnap
response files since the verification information is already captured in the reply file.

e Calypso will refer to the Feed Address Mappings defined for Getsnap to map the Bloomberg Quotes in the
Getsnap reply files to the appropriate Calypso Quotes.

e As with other program types, Bloomberg exceptions and information for Getsnap updates are viewable in
Calypso Task Station.

3.6 Manually Importing a Getsnap Reply File

You can manually import and reprocess a Getsnap reply file obtained from the Bloomberg FTP.

To import the file, open the Bloomberg Connect window and select the Import From File tab:
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Z BloombergConnect (User: calypso_user) E _ (ol x|
Utilities =10l
Request Import From File I

Bloomberg File: IC:'FIE_BHISMZGG.Dut Import | |

Select the reply file you wish to work with, then click Import.
Cancelling a Getsnap Request

You can cancel a periodic Getsnap request using the cancel program.

3.7 Getsnap Request File Format

Format:

START-OF-FILE

Header

START-OF-FIELDS

Fields (Fixed and Additional) END-OF-FIELDS
START-OF-DATA

Data

END-OF-DATA END-OF-FILE

3.71 Header
Getsnap Header Fields

Field Value Notes

SNAPTIME If the environment property Determines the time that Bloomberg will
BLOOMBERG_SERVERTZ is not set, | process request file.

will be the value entered in
Bloomberg Update Window Exec
Time field. If
BLOOMBERG_SERVERTZ is set, the
application converts the value
entered in Bloomberg Update
Window Exec Time field from the
local timezone to the timezone
specified by
BLOOMBERG_SERVERTZ.

DELAY_LIMIT Entered in Bloomberg Update Requires Bloomberg to produce reply file within
window this number of minutes; securities with longer
Delay Limit field. ﬁlrgbargoes are not included in the response
May 2022 Revision 2.0 / Approved Page 13/ 25
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Field VEIE Notes
PROGRAMFLAG Entered in Bloomberg Update Determines how often to process the request.
window

Frequency field

PROGRAMNAME getsnap |dentifies the request file as for the getsnap
program.
FIRMNAME Entered in Environment Property or | BLOOMBERG_FTP_USER or
Feed Config BLOOMBERG_ACCOUNT_NAME if

BLOOMBERG_FTP_USER is already used, or
user name from Feed Config if specified

RUNDATE Entered in Bloomberg Update Determines the start date for which the request
window Run Date field is to be processed.
REPORT Yes The Getsnap report generated by Bloomberg is

neither downloaded nor processed by Calypso,
however, this flag is set to remain consistent
with other Bloomberg Update programs.

REPLYFILENAME request_file_name without
the .out.enc extension
SN Entered in Environment Property Serial number. Needed for terminal user
BLOOMBERG_SN designation. This field is included only if the
Environment Property has a value.
WS Entered in Environment Property Workstation number. Needed for terminal user
BLOOMBERG_WS designation. This field is included only if the
Environment Property has a value.
USERNUMBER Entered in Environment Property Needed for terminal user designation. This field
BLOOMBERG_USERNUMBER is included only if the Environment Property has
a value.
VOL_SURFACE Yes Used for importing Money Market bonds.
CLOSINGVALUES Yes Used for importing Money Market bonds.
3.7.2 Fields
Fixed Fields

The fields below are automatically included to return values in the reply file. They are not listed in the request file.

o SECURITIES
e ERROR CODE
e NUMFLDS
May 2022 Revision 2.0 / Approved Page 14/ 25
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e OPEN PRICE

¢ HIGH PRICE
e LOW PRICE
e BID PRICE
e MID PRICE
e ASKPRICE
e BID YIELD
e MIDYIELD
e ASKYIELD
e LAST PRICE
e LASTYIELD

e LAST UPDATE TIME

e PREVIOUS CLOSE PRICE

e PREVIOUS CLOSE DATE

e PRICING SOURCE
Addlitional Fields
Users can specify additional fields.

NOTE: Additional fields specified in this region will be included in the Bloomberg update files.

However, Calypso does not process these additional fields. Calypso uses pre-existing functionality to map and
incorporate reference data from the Bloomberg Data Server. The function of Getsnapis to retrieve quote data from
Bloomberg, not reference data.

Quote value mappingis handled in the data feed map window, and incorporating quotes only requires the security
ID and quote values. The existing mapping functionality will remain in place for pulling reference data, but mapping
simply does not apply to pulling quotes for Getsnap.

3.7.3 Data

Securities listed here are from the Template selected in the Bloomberg Update Window. The securities must also
have their mappings definedin the Data Feed Mapping window for the Getsnap feed. Securities without a defined
mapping are ignored.

3.7.4 Sample Request File

START-OF-FILE

REPORT=yes FIRMNAME=dlxxxxx
REPLYFILENAME=testgetsnap.out.enc
SNAPTIME=0900 DELAY LIMIT=3
PROGRAMNAME=getsnap

PROGRAMFLAG=oneshot
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START-OF-FIELDS MARKET SECTOR DES END-OF-FIELDS

START-OF-DATA
BMW GY Equity IBM US Equity

AHA LN 03/18/11 C2600 Equity GB0033280339|ISIN| CH0114507210 Corp EQ0017443700001000|BB_UNIQUE| END-OF-DATA

END-OF-FILE

3.8 Getsnap Reply File Format

Format:

START-OF-FILE

Header

START-OF-FIELDS

Fields

END-OF-FIELDS TIMESTARTED START-OF-DATA
Data

END-OF-DATA TIMEFINISHED END-OF-FILE

Field Value

PROGRAMFLAG Same value as in request file

FIRMNAME Same value as

in request file

REPLYFILENAME Same value as in request file

SNAPTIME Same value as in request file

DELAY_LIMIT Same value as in request file

RUNDATE Same value as in request file

PROGRAMNAME Same value as in request file

REPORT Same value as in request file

SN Same value as in request file

WS Same value as in request file

USERNUMBER Same value as in request file
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3.8.1 TIMESTARTED

Time Bloomberg started to process request file.

3.8.2 Data
Security ID | Return Code | Number Fields | Fixed Fields (| Delimited) | Fields Listed in Request File (|
Delimited)

The return codes are:

Return Code | Definition

0 Good return. No errors occurred.
10 Bloomberg cannot find the security as specified.
1 Restricted Security. Must link to Bloomberg Professional™
with access.
100 Maximum number of securities exceeded (20,000)
150 Security blocked due to embargo not being met
988 System Error on security level
989 Unrecognized pricing source
990 System Error (Contact Technical Support)
991 Invalid override value (e.g., bad date or number)
992 Unknown override field
993 Maximum number of overrides (20) exceeded
994 Permission denied.
995 Maximum number of fields exceeded.
996 Buffer Overflow (some data for this security is missing).
997 General override error (e.g., formatting error)
998 Security identifier type (e.g., CUSIP) is not recognized.
999 Unloadable security
May 2022 Revision 2.0 / Approved Page 17/ 25
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3.8.3 Fields
Fixed Fields

The Fixed Fields, in order, are:

e SECURITIES
e ERROR CODE
e NUM FLDS
e OPEN PRICE
e HIGH PRICE
e LOW PRICE
e BID PRICE

e MID PRICE

e ASKPRICE
e BIDYIELD

e MIDYIELD

e ASKYIELD
e LAST PRICE
e LAST YIELD

e LAST UPDATE TIME
e PREVIOUS CLOSE PRICE
e PREVIOUS CLOSE DATE
e PRICING SOURCE
Additional Fields
Users can specify additional fields.
NOTE: Additional fields specified in this region will be included in the Bloomberg update files.

However, Calypso does not process these additional fields. Calypso uses pre-existing functionality to map and
incorporate reference data from the Bloomberg Data Server. The function of Getsnapis to retrieve quote data from
Bloomberg, not reference data.

Quote value mapping is handled in the data feed map window, and incorporating quotes only requires the security
ID and quote values. The existing mapping functionality will remain in place for pulling reference data, but mapping
simply does not apply to pulling quotes for Getsnap.

3.8.4 TIMEFINISHED
The time that Bloomberg finished processing request file.

Calypso uses the date and time of TIMEFINISHED as the quote date when entered into the Calypso database.

May 2022 Revision 2.0 / Approved Page 18 / 25
Private and Confidential



Nasdaq Calypso
I'INanaq Bloomberg DL Market Data Integration Guide / Version 11.8.9

3.8.5 Sample Reply File

This sample reply file corresponds is a response to the sample request file.
START-OF-FILE RUNDATE=20110311

PROGRAMFLAG=oneshot FIRMNAME=dlxxxxx REPLYFILENAME=testgetsnap.out.enc SNAPTIME=0900
DELAY LIMIT=3

PROGRAMNAME=getsnap
START-OF-FIELDS MARKET SECTOR DES END-OF-FIELDS
TIMESTARTED=Fri Mar 11 09:00:00 EST 2011

START-OF-DATA

SECURITIES |ERROR CODE |NUM FLDS|OPEN PRICE|HIGH PRICE|LOW PRICE|BID PRICE|MID PRICE|ASK PRICE|BID YIELD|MID
YIELD|ASK YIELD|LAST PRICE|LAST YIELD|LAST UPDATE TIME|PREVIOUS CLOSE PRICE|PREVIOUS CLOSE DATE|PRICING
SOURCE | MARKET SECTOR_DES |

BMW GY Equity|150(16] | | | | | | | | | | | | | | [|Equity| IBM US
Equity|0]16]164.640000/164.670000]161.380000(162.030000/162.025000(162.

020000 | | 1162.020000| |03/10/20111162.020000(03/10/2011|US|Equity| AHA LN 03/18/11 C2600 Equity|0|16]| |
1519.5000001534.000000|548.500000| | | 1513.500000]

|03/10/20111513.500000(03/10/2011|LN|Equity|
GB0033280339(0116[109.962500(1110.230000]109.962500(110.155000(110.16500
01110.175000(12.349000/2.34680012.344500/110.165000/2.346800(08:58:58]10

9.840000/03/10/2011|BGN|Govt| CH0114507210

Corp|0]16/100.439000/100.7800001100.439000/100.446000/100.648000(100.85
1000(2.15900012.119000]2.078000|100.648000(2.119000[08:58:53]100.597000

|03/10/2011|BGN|Corp|
EQ0017443700001000/01161212.000000]1215.000000/208.250000(1211.700000]211
.5000001211.300000( | | 1211.300000]

|06:06:18]211.300000/03/11/2011|IN|Equity| END-OF-DATA
TIMEFINISHED=Fri Mar 11 09:00:10 EST 2011

END-OF-FILE
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Volatility Surfaces

4.1 Swaption Lognhormal

A Bloomberg Update

1 Bloomberg Updates
[+ oneshot

Wk

Update Definition

Program:  getdata V|
Name: |sysaption |
Frequency: oneshot V|
| Add Custom Header |
Feed: | V|
Columns
Name

BVOL_DATA_TIME_STAMP

Template Type: | Swaption

£

Currency USD

£

Rate Index: LIBOR

Tenor: |6M V|

Run Date:

(YYYYMMDD)

Exec Time: (HHMM)

Type
~ Update - No Task

BVOL_OIS_SWAPTION

~ Update - No Task

REFERENCE_DATE

~ Update - No Task

BLOOMBERG_UPDATE:

Attribute Value
Action 1 - Send Request for Updates
DIFFFLAG
|Update Mames
Input Dir
Input Files swaption
Attribute Value
Action 2 - Process Updates Received
DIFFFLAG
Update Names
Input Dir
Input Files swaption
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IOI Nasdaq

_A VolatilitySurface3D VOL - USD_Swaption_OIS - BBG USD CLOSE LIBOR 6M User{calypso_user}(PE OFFICIAL)

| Surface  Utilities Help

Mame |'OL - USD_Swaption_OIS -BBG | | CLOSE

Definition | Offsets | Points | Graph

Comment

w | Date |05/24/2016 3:03:49 PM [ Current

Generated from Bloomberg data on 05/25/2016

Vol Type [paTE Vol Model [glack

Currency :USD v: Generator | perived Defauit

Index [50R 2 lem + | Interpolator |Interpolator3DLinear

Point Underlying |yone z)

Parameter Value

Include Tenor Axis

Pricing Environment |

OFFICIAL

Definition I Dﬂ"'sets| Points | Graph|

- r . |Spot Lag -
strke Tvpe | Strke Offset bp * | [SYNTHETIC_EXPIRY

DateRol [Mop_FoLLOW =] SYNTHETIC_TENCR

Holidays |nyc,Lon ()

@ Temor () Expiry () Strike  Tenor :1’1’

VolatiityModel: Black MID

Private and Confidential

Expiry/Offsetbp 0 -200 -100 -50 -25 25 50

06/24/2016 45,2213000000| 20.7735000000( 20.7736000000( 20.7735000000( 6.9459000000| -3.1433000000| -4.21%
08242016 44, 2877000000 206.2047000000| 206.2047000000( 18.0156000000( 6.18375000000( -2.8490000000( -3.824
11/24/2016 46.0637000000| 82.1433000000( S88.1483000000( 15.3891000000| 5.6937000000| -3.3342000000| -5.244
02/24/2017 43.,0753000000| 48.0753000000( 48.0753000000( 48.0753000000| 48.0753000000| 48.0753000000| 48.07%
05/24/2017 49,3014000000| 54.0394000000( 54.0394000000( 12.9338000000( 5.1110000000| -3.4756000000| -5.890
05/24/2018 53.1901000000| 38.7856000000| 38.7856000000( 11.4960000000( 5.1234000000( -3.6211000000 -6.074
05/24/2019 57.5886000000| 57.5886000000| 57.5886000000| 57.5886000000| 57.5886000000| 57.5886000000| 57.588
05/242020 54,2070000000| 54,2070000000| 54.2070000000( 54.2070000000( 54.2070000000| 54,2070000000| 54,207
05/24/2021 50,2533000000| 20,9563000000| 20.9563000000( 7.7493000000( 3.5429000000| -2.9154000000| -4.974
05/24/2022 45,5512000000| 46.5512000000( 46.5512000000( 46.5512000000( 46.5512000000| 46.5512000000| 46.551
05/24/2023 43.7305000000| 43.7305000000( 43.7305000000( 43.7305000000| 43.7305000000| 43.7305000000| 43.730
05/24/2024 41.0422000000| 41.0422000000( 41.0422000000( 41.0422000000( 41.0422000000| 41.0422000000| 41.042
05/24/2025 33,7223000000| 38.7223000000| 38.7223000000( 38.7223000000| 38.7223000000| 33.7223000000| 38,722
05/24/2026 36,5602000000|  58,9290000000 9.6045000000( 3.9912000000( 1.9708000000| -1.6434000000( -2.794
05/24/2031 30.2173000000|  32.9310000000 6.8106000000( 2.9299000000| 1.4927000000| -1.2487000000| -2.068
05/24/2036 27.5343000000| 49,6726000000 6.3133000000( 2.7227000000( 1.4064000000| -1.1655000000( -1.881
05/24/2041 25.8134000000| 25.8134000000( 25.8134000000( 25.3184000000| 25.3134000000| 25.8134000000| 25.811
05/24/2046 25.9184000000 8.4873000000 8.4873000000( 3.3464000000( 1.6332000000| -1.3124000000| -2.235
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4.2 Swaption Normal

A Bloomberg Update

[ Bloomberg Updates
[+ oneshot

N

Update Definition

Program: | getdata
Hame: | swaption_normal
Frequency: oneshot

Add Custom Header

Feed:

Columns

Name
BVOL_DATA_TIME_STAMP

Template Type: | Swaption
Currency USD
Rate Index: LIBOR
Run Date:
Exec Time:

Vol Model:

Type
~ Update - No Task

Tenor: | 6M
(YYYYMMDD)
(HHMM)

£

BVOL_OIS_SWAPTION

~ Update - No Task

REFERENCE_DATE

~ Update - No Task

BLOOMBERG_UPDATE:

Attribute Value
Action 1 - Send Request for Updates
DIFFFLAG
|Ipdate Mames
Input Dir
Input Files swapn_normal
Attribute Value
Action 2 - Process Updates Received
DIFFFLAG
Ipdate Names
Input Dir
Input Files swapn_normal
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_A VolatilitySurface3D VOL - USD_Swaption_OIS - BBG USD CLOSE LIBOR 6M User{calypso_user)(PE OFFICIAL) |

Surface  Utilities

Help

MName |'OL - USD_Swaption_QIS - BBG | | CLOSE

Definition | Offsets | Points | Graph

w | Date |05/24/2016

3:03:45 PM

[ current

Comment

Generated from Bloomberg data on 05/25/2016

Vol Type
Currency
Index

Paint Underlying

Holidays

RATE
usD
LIBOR

None

-

Include Tenor Axis
Strike Type |Strike Offsetbp
DateRoll |MoD_FoLLOW

NYC,LON

Pricing Environment | orrIcIaL

Definition | OFFsets| Points | Graph|

Val Mode! [gpyol

Generator [~ perived | Default

Interpolator .I.nberpolahar.'ﬂLinear

Parameter
. |Spot Lag

Value

| [SYNTHETIC_EXPIRY

| |SYNTHETIC_TENOR

@ Tenor () Expiry () Strike  Tenor | - VolatilityModel: BpVal MID -
Expiry/Offsetbp O -200 -100 -75 -50 -25
06/24/2015 4213,6200000000( 4213.6200000000| 4213.6200000000( 4213.6200000000) 4213.6200000000| 4213.62000001
03/24/2016 4460,6000000000( 1566, 7100000000 538.5300000000( 283, 5000000000 744700000000 -39, 23000001
11/24/2016 4993, 2500000000( 734, 1000000000 1798200000000 55.0600000000| -33.7100000000,  -60.46000000
02/24/2017 5558.0000000000( 5558.0000000000) 5553.0000000000( 5558.0000000000) 5558.0000000000| 5558.00000001
05/24/2017 5984, 3700000000 80.7100000000| -127.2100000000| -143.0100000000| -138,8900000000(  -91.40000001
05/24/2018 7523.8500000000( 7523.8500000000| 7523.8500000000( 7F523.8500000000) F523.8500000000| 7523.85000001
05/24/2019 8472.1300000000( 8472.1300000000| 28472.1300000000( 8472.1300000000) 8472.1300000000| 23472, 13000001
05/24/2020 3341, 1800000000( 8541, 1300000000 23341,1300000000( 5341.1300000000) 3841, 1300000000 3341, 18000001
05/24/2021 3966,8300000000( 8966.8300000000| 3966,8300000000( 3966.3300000000) 8966.8300000000| 3966,83000001
05/24/2022 3892, 3600000000( 8892, 3600000000 3892,3600000000( 3392.3600000000| 83892.3600000000| 3892, 36000001
05/24/2023 8806, 5000000000( 8806, 5000000000 28806.5000000000( 8306.5000000000| 8806.5000000000| 23806, 50000001
05/24/2024 3642,6100000000( 8642.6100000000| 23642.6100000000( 55642.6100000000) 83642.6100000000| 3642.61000001
05/24/2025 3482, 1000000000( 8432, 1000000000 34582,1000000000( 3432.1000000000) 84582, 1000000000| 3482, 10000004
05/24/2025 8315, 3500000000( 8315.3500000000| 8315,.3500000000( 8315.3500000000) 8315.3500000000| 8315,35000001
05/24/2031 7230.6500000000( 7230.6500000000| 7230.6500000000( 7230.6500000000) 7230.6500000000| 7230.65000001
05/24/2036 5337, 2500000000( &337.2500000000| &337.2500000000( &337.2500000000) &337.2500000000| &337,25000001
05/24/2041 5754.0900000000( 5754.0900000000) 5754.0900000000( 5754.0900000000) 5754.0900000000| 5754.09000001
05/24/2046 5411, 5600000000( 5411.5600000000) 5411.5600000000( 5411.5600000000| 5411.5600000000| 541156000001
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4.3 Cap Floo

A Bloomberg Update

r

E Bloomberg Updates
(-2 oneshot

Wi

BLOOMBERG_UPDATE:

Update Definition

Program: | getdata
Name: | CapFloor
Frequency:  oneshot

Add Custom Header

Feed:

Columns

Name
BVOL_DATA_TIME_STAMP

~ Template Type: | CapFloor

Currency USD

~ Rate Index: |LIBOR

Run Date:
Exec Time:

Type
~ Update - No Task

Tenor:
(YYYYMMDD)
(HHMM)

REFERENCE_DATE

~ Update - No Task

BVOL_IBOR_CAP

~ Update - No Task

Attribute Value
Action 1 - Send Request for Updates
DIFFFLAG
|Ipdate Mames
Input Dir
Input Files CapFloor
Attribute Value
Action 2 - Process pdates Received
DIFFFLAG
|Ipdate Mames
Input Dir
Input Files CapFloor
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A VolatilitySurface3D VOL - USD_CapFloor IBOR - BBG USD CLOSE LIBOR 6M User(calypso_user)(PE OFFICIAL) | ]

Surface Utilities Help
Name |JL - USD_CapFloor_IBOR. - BBG .CLOSE v. Date |05/24/2016 3:03:49PM [ Current
| Defintion | offsets | Points | Graph|

Comment |Generated from Bloomberg data on 05/25/2016

Vol Type [paTE - Vol Model |glack

Currency usp v|  Generator [ perived |Defauit

Index |L1BOR - &M v | Interpolator [Interpolator3DLinear
[ Indude Tenor Axis Parameter Value
- . |5potL hd
Strike Type | strike ) spovmaag'lc_acpm
DateRoll .MDD_FOLLDW ] SYNTHETIC_TEMOR.
Holidays [nvc,Lom [
Pricing Environment | QFFICIAL |
| Definition | CJF’Fsets| Peints | Graph|
VolatiityModel: Black MID »
Expiry/Strike 0 1 L5 2 3 3.5 4
05/24/2017 49,6026000000( 43,6870000000| 42,2571000000( 40,7113000000| 41,3377000000) 42,0495000000( 42.73540000
05/24/2015 49,2584000000( 51.0995000000| 44, 7427000000( 41.9191000000| 39.7751000000) 39,4752000000( 39.40350000
05/24f2013 54,3301000000( 59.0319000000| 50,4257000000| 45,3130000000( 42.6292000000| 41.7817000000| 41,24730000
05/24/2020 57.6891000000( £4.9538000000| 54.31832000000| 49.0666000000( 44.1571000000| 42.9331000000| 42.10290000
05/24/2021 58,8300000000( &8,8298000000| 56,5530000000| 50,3411000000( 44.3648000000| 42.3137000000| 41,73830000
05/24/2022 58,0732000000( 70,5305000000| 57,1967000000| 50,2756000000( 43.4001000000| 41,5673000000| 40,25830000
05/24/2023 56,8381000000( 714835000000 57,3561000000| 49,9626000000( 42.5551000000| <40,5721000000| 39,16650000
05/24/2024 55.0993000000( 71.6154000000| 56.9406000000| 49,1745000000( 41.2330000000| 39.1500000000| 37.63030000
05/24/2025 53,5283000000( 71,7055000000| 56,5596000000| 48,5227000000( 40.3255000000| 33.1039000000| 356,53030000
05/24/2025 52,1200000000( 718272000000 56,2397000000| 47,9783000000( 39.5506000000| 37.2857000000| 35.68770000
05/24f2025 43,3451000000( 70,1011000000| 54,2055000000( 45,7558000000| 37.1269000000| 34.8319000000( 33.24000000
05/24/2031 44,9583000000| &9,3808000000| 52,7387000000( 44.0308000000| 35.2651000000| 32.99159000000( 31.44530000
05/24/2036 40,3699000000| 66,5540000000| 49,68374000000( 41.0039000000| 32.4960000000) 30,3996000000( 29.01330000
05/24/2041 38,7339000000| &7,4531000000| 49,0573000000( 40.0684000000| 31.5479000000| 29,5320000000( 28.23520000
05/24/2046 38,2487000000( 70,2099000000| 49,4973000000( 39,98399000000| 31.2842000000| 29,2917000000( 258.03320000
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